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Copyright Notice
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted 
in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior 
written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for 
use with this EPSON scanner. EPSON is not responsible for any use of this information as applied to other 
scanners.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or 
third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: 
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, 
or (excluding the U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and 
maintenance instructions.

SEIKO EPSON CORPORATION and its affiliates shall not be liable for any damages or problems arising from 
the use of any options or any consumable products other than those designated as Original EPSON Products 
or EPSON Approved Products by SEIKO EPSON CORPORATION.

A Note Concerning Responsible Use of Copyrighted Materials
Digital cameras and scanners, like photocopiers and conventional cameras, can be misused by improper 
copying of copyrighted material. While some countries’ laws permit limited copying of copyrighted material in 
certain circumstances, those circumstances may not be as broad as some people assume. EPSON 
encourages each user to be responsible and respectful of copyright laws when using digital cameras and 
scanners.
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Introduction

EPSON® TWAIN is the interface program between your application 
software and scanner that lets you scan images into your software. It is 
the ideal interface for producing professional quality images, scanning 
text into optical character recognition (OCR) programs, and managing 
text pages in NewSoft™ Presto!™ PageManager. 

EPSON TWAIN includes many features for previewing and modifying 
your images for the perfect scan:

◗ Captures all kinds of images, from black and white text to color images

◗ Opens a preview image allowing you to change settings and view their 
effects before you scan

◗ Provides a helpful marquee feature so you can frame the exact image 
borders or only portions of it for scanning

◗ Gives you settings for a variety of image types and output destinations

EPSON TWAIN also comes with these utilities:

◗ EPSON Scan Events (Windows® 98) or Scanner Monitor (Macintosh®) 
utilities that let you scan with Presto! PageManager using the EPSON 
Perfection™ 610 Start button

◗ EPSON Screen Calibration utility to calibrate your screen to your 
scanner for accurate previews
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System Requirements 
Before installing the scanner software, make sure your system meets the 
following requirements.

Windows 98 System Requirements
◗ An IBM® compatible PC with a 486/66 MHz or faster processor

◗ Microsoft® Windows 98 preinstalled

◗ 16MB RAM (32MB recommended)

◗ 50MB available hard disk space

◗ Available USB port or hub connection

◗ CD-ROM drive

◗ Mouse or pointing device

◗ VGA or higher resolution monitor with 640 × 480 resolution (800 × 600 
or higher recommended) and 256 colors (65,000 colors or more 
recommended)

The color and tone of 
your scanned image 
depend on the display 
capabilities of your 
computer system, 
including the video 
controller, monitor, 
and software. 
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Macintosh System Requirements
EPSON TWAIN supports the Apple® ColorSync™ 2.X color management 
system and QuickTime.™ 

◗ Apple Macintosh computer (G3 or iMac™ ) running Mac OS 8.1, or 
Mac OS 8.5 or later 

◗ Available USB port or hub connection

◗ 32MB RAM (64MB recommended)

◗ 50MB available hard disk space

◗ CD-ROM drive

◗ Mouse or pointing device

◗ VGA color monitor with 640 × 480 screen resolution (or higher 
recommended) and 256 colors (32,000 colors or more recommended)

How To Use This Manual
For instructions on installing EPSON TWAIN, see the Scanner Basics 
book. This User’s Guide tells you what you need to know to scan with 
EPSON TWAIN and to use the TWAIN utilities. 

Scanning gives step-by-step instructions for scanning and previewing of 
your images.

Using the EPSON TWAIN Utilities tells you how to use the scanner 
monitor utilities and EPSON Screen Calibration.

If your system is 
running OS 8.1, you 
must download and 
install the iMac Update 
1.0 from Apple at 
http://swupd ates.in fo
.appl e.com before you 
install the EPSON USB 
software. Contact 
Apple Computer if you 
have problems 
installing this update. If 
your system is running 
OS 8.5, you don’t need 
this update. Your 
operating system 
already includes full 
support for the EPSON 
USB software.
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Using the Start Button gives step-by-step instructions on setting up and 
using your scanner’s Start button for one-touch scanning.

Troubleshooting provides solutions to problems you may encounter.

At the end, you’ll find a Glossary and an Index.

Cautions, Notes, and Tips
You’ll find this information throughout your manual:

Cautions must be observed to avoid damage to your equipment.

Notes contain important information about your scanner.

Tips contain additional hints for better scanning.

Using Electronic Links
Underlined text indicates a link (cross-reference) to other parts of this 
guide. Click on the link text with the mouse pointer to view the referenced 
information. 
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Scanning

Before scanning, make sure you’ve installed the EPSON TWAIN software 
(as described in the Scanner Basics book) and the application software 
that supports EPSON TWAIN, such as PictureWorks™ HotShots™ or 
Presto! PageManager.

This chapter includes the following information:

◗ Scanning Overview

◗ Starting EPSON TWAIN

◗ Selecting Settings

◗ Previewing Your Scan

◗ Using Marquees

The screen examples 
in this book are from 
EPSON TWAIN for 
Windows. The screens 
for Macintosh look a bit 
different, but they 
contain the same 
options. Any 
exceptions are noted 
in the text.
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Scanning Overview
Here is a brief overview of scanning steps using EPSON TWAIN (the 
Windows interface is shown; the Macintosh steps are the same):

4 Click Scan.

2 Select your 
basic scan 
settings.

3 Draw a marquee 
around the area 
you want to scan.

1 Select the tab for your scan: 
Photo  or OCR/Line Art .

3 Draw a marquee 
around the area 
you want to scan.
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Starting EPSON TWAIN
Follow the steps in this section to start EPSON TWAIN from your 
application software. The steps may vary, depending on your application. 

1 Make sure you set up and plugged in the scanner. Then place the 
document you want to scan on the document table. See the Scanner 
Basics book for instructions.

2 Start your application software by selecting the program icon in its 
program folder.

3 Select the scanner source. Open the File menu and choose Import , 
Acquire , or Select Source , and then select either Select TWAIN_32 
Source  (Windows 98) or TWAIN Select  (Macintosh). 

If you start your 
application software 
before turning on your 
scanner, the software 
may not work properly.

The steps in this 
section cover scanning 
with common 
TWAIN-compliant 
applications. Other 
applications, such as 
HotShots, use different 
scanning steps. See 
your Scanner Basics 
book for instructions 
on scanning with 
HotShots; see your 
application’s 
documentation for 
additional details on 
scanning.

Click to select 
the scanner 
source
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4 Select EPSON TWAIN L  and click Select . 

5 Start EPSON TWAIN for scanning. Open the File menu and choose 
Import  or Acquire  and then select either TWAIN_32 (Windows) or 
TWAIN Acquire (Macintosh).

Click to open 
EPSON 
TWAIN
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The EPSON TWAIN window appears.

The EPSON TWAIN window contains the basic settings you need to scan 
an image. See Selecting Settings for details.

It also lets you preview your image. See Previewing Your Scan for details.

To keep file size small when scanning at higher resolutions, you should 
use a marquee around only the scanning area. See Using Marquees for 
details.
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Selecting Settings
You need to scan using the tab for the type of image you are scanning 
(Photo or OCR/Line Art) and check the basic settings.

Scanning Photographs
1 Select the Photo  tab.

2 Select the correct Image Type setting. Select one of the following 
options: Color Photo  or Black and White Photo .

image type

resolution

color 
management

image quality 
effects
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3 If you need to change the resolution, select a new setting from the 
Resolution list. If you are scanning something that will be used on a 
web page, you can select 75 dpi  for your resolution setting. If you plan 
to print your image or enlarge it, you should choose a higher resolution 
such as 300 dpi  or 600 dpi .

4 Select Quality  or Speed  under the Color Management settings. 

You can also select De-screening  (eliminates moiré patterns) and 
Unsharp Mask  (sharpens the image) to adjust the quality of your 
scan.

5 When you’re ready to scan, draw a marquee around the area you want 
to scan and click the Scan  button. The scanned image appears in your 
application window.

6 Click the Close  button to close the EPSON TWAIN window and return 
to your application.

7 To modify or save your scanned image using your application 
software, see your software documentation.

Make sure you use a 
marquee to select the 
scan area, especially if 
you are scanning at a 
resolution of 300 dpi, or 
higher. See Using 
Marquees for details.
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Scanning Text or Line Art
1 Select the OCR/Line Art  tab.

2 Select a threshold setting. These automatically select resolution and 
sharpness settings appropriate for the output type. Select one of the 
following options: Newspaper , Magazine , Printout , Book , or User  
Defined .

If you select User  Defined , adjust the slider until the preview looks the 
way you want your image to appear.

resolution

threshold 
settings

threshold 
slider
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3 If you need to change the resolution, select a new setting from the 
Resolution list. If you are scanning something that will be used on a 
web page, you can select 75 dp i for your resolution setting. If you plan 
to print your image or enlarge it, you should choose a higher resolution 
such as 300 dpi .

4 When you’re ready to scan, draw a marquee around the area you want 
to scan.

5 Click the Scan button. The scanned image appears in your application 
window.

6 Click the Close button to close the EPSON TWAIN window and return 
to your application.

To modify or save your scanned image using your application 
software, see your software documentation.

Make sure you use a 
marquee to select the 
scan area, especially if 
you are scanning at a 
resolution of 300 dpi, or 
higher. See Using 
Marquees for details.
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Previewing Your Scan
You can preview your image to see the effects of your settings before 
scanning. Previewing also allows you to determine the width and height of 
the scanned image and the final file size. 

Configurin g Preview Settings
Click the Configuration  button. You see the following screen.

Check Automatic  Preview  to automatically preview the scan and update 
it as you make resolution and other setting changes. 

Check Save Preview  Image  and  Settings  if you want to see the preview 
with the same settings the next time you open EPSON TWAIN.

Previewing Your Image Manually
If you did not select Automatic Preview  in the Configuration settings and 
you want to see a preview of your scan, click the Preview  button on the 
EPSON TWAIN window.
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Using Marquees
A marquee is a frame around an entire image, or a portion of an image so 
you can scan only the most important part. To create a marquee, follow 
these steps:

1 Move the mouse pointer over the preview image; the pointer becomes 
a cross hair. 

2 Position the pointer in the corner of the area you want to select and 
press the mouse button.

3 Hold down the mouse button as you drag the mouse across the image, 
creating a marquee. 

4 Release the button when the marquee contains the image area you 
want.

5 When you’re ready to scan, click the Scan  button. The scanned image 
appears in your application window.

If you need to adjust the marquee size or position, or delete the marquee, 
see Adjusting a Marquee.

If the mouse pointer 
doesn’t change to a 
cross hair, click the 
Preview  button again.

marquee
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Adjusting a Marquee
To resize a marquee, place the mouse pointer over 
its edge; the pointer changes to a double-headed 
arrow. Click the mouse button and drag the box up, 
down, sideways, or diagonally to the size you want. 

To resize a marquee and retain its width-to-height 
proportions, hold down the Shift  key as you drag the 
edge of the marquee.

To move a marquee, place the mouse pointer 
anywhere in the marquee image area; the pointer 
changes to a hand. Click the mouse button and drag 
the entire marquee to move it where you want it.

To delete a marquee, click outside the marquee 
area. 
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Using the Start Button

The scanner’s Start button lets you set up your system for one-touch 
scanning with Presto! PageManager and a scanner monitoring utility. 
With one-touch scanning, you can load a document in the scanner, press 
the Start button, and watch while PageManager starts and then opens 
EPSON TWAIN automatically. You can even set up PageManager to 
automatically load your scanned document into another application—
such as HotShots—or send it to another device—such as your printer.

Preparing to Use the Start Button
To use the Start button, you must have installed PageManager (see the 
Scanner Basics book for installation instructions). With Windows 98, you 
can also use other programs that support linking to scanner events with 
the Start button, such as Photoshop® 5.0 and Windows Imaging. Then 
you must enable scanner monitoring and configure PageManager (or 
another compliant application) to handle your scanned images.

Follow the instructions in these sections to set up Start button scanning:

◗ Enabling Scanner Monitoring

◗ Setting Up PageManager for Start Button Scanning

When you’re ready to use the Start button, follow the instructions in 
Scanning with the Start Button.
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Enabling Scanner Monitoring
When you installed EPSON TWAIN on your system, the installer 
automatically installed the TWAIN utilities, including these scanner 
monitoring utilities:

◗ Scan Events monitor in the Scanners and Cameras utility 
(Windows 98)

◗ EPSON Scanner Monitor (Macintosh)

These utilities let your scanner’s Start button communicate with your 
operating system and open PageManager (or another Windows 98, Start 
button compliant program).

Follow the steps in these sections to enable scanner monitoring:

◗ Setting Up Monitoring for Windows 98

◗ Setting Up Monitoring for Macintosh
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Setting Up Monitoring for Windows 98
The Scan Events monitor installed into the Windows 98 Scanners and 
Cameras utility is automatically enabled and ready to scan to 
PageManager (and any other Start button compatible programs) when 
you press the Start button.

If you ever want to disable (or enable) Start button scanning, follow these 
steps:

1 Click Start , point to Settings , and click the Control Panel  icon.

2 Click the Scanners and Cameras  icon. You see this dialog box:

3 If necessary, click the Devices  tab. Click your scanner name in the 
box, then click the Properties  button.

Devices tab

scanner name

Properties button
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4 Click the Events  tab. You see this dialog box:

5 To disable Start button scanning, click the Disable device events  
checkbox; a check appears in the checkbox.

To enable Start button scanning, click the Disable device events  
checkbox to uncheck it. Then click the checkbox for each application 
you’d like to be able to use with the Start button. If you select more 
than one application, you’ll be prompted for the application you want to 
use when you press the Start button.

6 Click OK .

Disable device 
events checkbox
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Setting Up Monitoring for Macintosh
The EPSON Scanner Monitor installed with EPSON TWAIN on the 
Macintosh is automatically enabled and set up to scan with PageManager 
when you press the Start button. 

If you ever want to disable the EPSON Scanner Monitor, do the following:

1 Select EPSON Scanner Monitor Setup  from the Apple menu; you see 
the EPSON Scanner Monitor dialog box. 

2 Click the Enable Monitoring  checkbox to uncheck it.

3 Click OK .

To enable monitoring, do the following:

1 Select EPSON Scanner Monitor Setup  from the Apple menu; you see 
the EPSON Scanner Monitor dialog box.

2 Click the Enable Monitoring  checkbox to check it.

3 Click OK .
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Setting Up PageManager for Start Button Scanning
To use PageManager with your scanner’s Start button, you must set up 
PageManager’s Scan Buttons palette and assign a destination program 
or device to the Start button. For example, if you want the images you 
scan to be sent directly to your image editing program, you can assign the 
Start button to HotShots (or another image editing program). 

The Scan Buttons palette appears on the screen whenever PageManager 
is running so you can select the destination program or device for your 
scanned images. (If it doesn’t appear, open the View menu and click the 
Scan Buttons  option.)

The icon that contains the Start button icon indicates where images 
scanned using the Start button will be sent. (You can select 
PageManager as the destination program for your scanned images if you 
don’t want them to load into a different program.) 

Follow the instructions in these sections to set up the Scan Buttons:

◗ Assigning a Destination to the Start Button

◗ Adding a Destination to the Scan Buttons Palette

◗ Reassigning Destinations on the Scan Buttons Palette

◗ Selecting Scan Button Settings

To set up other Start 
button compliant 
applications on 
Windows 98, see 
the application 
documentation for 
instructions.

The PageManager 
program icon on the 
Macintosh is different; 
it is shaped like a 
desktop inbox. See 
PageManager online 
help for details.

PageManager program 
icon with the Start button 
assigned to it
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Assigning a Destination to the Start Button
PageManager is the default destination program for the Start button. To 
assign another destination to the Start button, follow these steps:

1 Open the File menu and select Scan Buttons Setting . You see the 
Scan Buttons Setting dialog box. Click the Start Button Settings  tab.

2 To change the program or device assigned to the Start button, click its 
icon in the Select target application box.

3 If you want to automatically launch EPSON TWAIN within 
PageManager when you press the Start button, make sure the 
Execute Scan Button automatically  checkbox is checked. 

If you want to launch PageManager and display only the Scan Buttons 
palette when you press the Start button, click the Execute Scan 
Button automatically  checkbox to uncheck it. You’ll then need to click 
a button in the Scan Buttons palette to continue with your scan.

4 Click OK .

If you select a 
program or device for 
which you suppressed 
the TWAIN interface, 
be sure to set 
PageManager’s scan 
settings before you 
press the Start button. 
See Selecting Scan 
Button Settings for 
details.

select the icon for the 
program or device you 
want to assign to the 
Start button
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Adding a Destination to the Scan Buttons Palette
If you want to add program or device icons to the Scan Buttons palette, 
follow these steps:

1 Open the File menu and select Scan Buttons Setting . You see the 
Scan Buttons Setting dialog box. Click the Properties  tab, if 
necessary.

2 Click the Add  button. On the Macintosh, you see the Add scan button 
dialog box.

3 Click the arrow in the Scan to  (Windows) or Scan to App  (Macintosh) 
setting box. The Scan to setting lists the programs and devices on your 
system that PageManager can send your scanned file to. Select the 
program or device you want to add. An icon for it appears in the scroll 
bar on the left (Windows only).

Scan to 
setting list

Add button

Properties 
tab
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4 Type a name for the icon in the Name field. On an Macintosh, click OK 
to close the Add scan button dialog box.

5 If the Suppress TWAIN User Interface  checkbox is active, you can 
select whether you want PageManager to open the EPSON TWAIN 
dialog box when you press the Start button. 

If you don’t check the checkbox, the EPSON TWAIN dialog box 
appears after you press the Start button and PageManager opens. 
Then you can preview, select settings, and click Scan when you’re 
ready.

If you check the checkbox, PageManager suppresses the EPSON 
TWAIN dialog box and uses the settings described in step 6.

6 If you checked the Suppress TWAIN User Interface  checkbox in 
step 5, the PageManager scan settings become active.

For the best results, 
don’t suppress the 
EPSON TWAIN 
interface when 
scanning with the 
Start button. This lets 
you preview and 
adjust your image 
settings the way you 
want them before you 
scan.

active PageManager 
scan settings
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If these settings are active, select the scan settings you want to use 
whenever you press the program or device icon; see Selecting Scan 
Button Settings for details. 

7 If you want to assign a new destination program or device to the Start 
button, see Assigning a Destination to the Start Button for instructions.

8 When you’re finished adding programs or devices, click OK.
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Reassigning Destinations on the Scan Buttons Palette
You may want to reassign an existing icon to a different program or 
device, or just change its settings. For example, if you use more than one 
printer, you may want to reassign the printer icon to each printer as you 
need it.

1 Open the File menu and select Scan Buttons Setting ; then click the 
Properties  tab, if necessary.

2 Click the icon for the program or device you want to reassign in the 
scroll bar on the left of the dialog box. The current properties for the 
icon appear to the right.

3 To select a different program or device for the icon, choose it from the 
Scan to  (Windows) or the Scan to App  (Macintosh) setting list. 

4 If you checked the Suppress TWAIN User Interface  checkbox, 
change any of the active PageManager scan settings as necessary; 
see Selecting Scan Button Settings for details.

If you want to delete 
an icon from the Scan 
Buttons palette, 
select the icon in the 
scroll bar on the left 
of the dialog box and 
click the Remove  
button.

Properties tab

click the icon for the 
program or device you 
want to reassign

Scan to 
setting list
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5 If you want to assign a new program or device to the Start button, see 
Assigning a Destination to the Start Button for instructions.

6 When you’re finished reassigning destinations, click OK.

Selecting Scan Button Settings
If you select a device or program for which you’ve checked the Suppress 
TWAIN User Interface  checkbox, the PageManager scan settings 
become active. If they’re active, select the options you want to use 
whenever you press the destination icon in the Scan Buttons palette or 
assign the Start button to the icon.

active PageManager 
scan settings
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The table below describes the settings and their available options.

Setting Options Description

Document Type
(Windows only)

Magazine (Text and Picture)
Magazine (Picture)
Photograph
Document
Letter
Business Card
Others 

Select the type of original 
you’re scanning so 
PageManager can choose the 
best default options for the rest 
of the settings. Select Others to 
customize a different document 
type.

Scan Mode Color
Gray
Black and White

Select the color specification of 
the original you’re scanning.

Scan Size Legal 8.5 × 14 inches
Letter 8.5 × 11 inches
A4 210 × 297 mm
B5 182 × 257 mm
A5 148 × 210 mm
Custom (Windows only)
3 × 5 (Landscape) [Macintosh only]
3 × 5 (Portrait) [Macintosh only]
4 × 6 (Landscape) [Macintosh only]
4 × 6 (Portrait) [Macintosh only]
5 × 7 (Portrait) [Macintosh only]
5 × 7 (Landscape) [Macintosh only]
Business Card (Macintosh only)

Select the size of the area you 
want to scan. When you select 
Custom (Windows only), you 
see a Customize Size dialog 
box; select the measurement 
unit, type in the Width and 
Height values, and then click 
OK.



Using the Start Button Page 35

Resolution 72 300
100 360
150 400
200 600
240 800

Select the scanning resolution 
you want to use. You can’t type 
in a custom resolution.

Enable Document 
Feeder

Make sure this setting is not  selected. The document feeder option is 
not available for this scanner.

Brightness –100 to 100 Adjust the brightness of the 
scan as necessary. This setting 
appears only when the Scan 
Mode is set to Color or Gray.

Contrast –100 to 100 Adjust the contrast of the scan 
as necessary. 

Threshold 0 to 255 Adjust the threshold for the 
highlights and shadows of the 
scan as necessary. This setting 
appears only when the Scan 
Mode is set to Black and White 
and replaces the Brightness 
setting.

Setting Options Description
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Scanning with the Start Button
Once you’ve set up your scanner monitoring utility and configured 
PageManager to handle your scanned images the way you want, you’re 
ready to scan with the Start button. 

The sequence of steps varies (as noted in the text), depending on 
whether you’ve elected to suppress the TWAIN interface or not, and 
whether you’ve set up PageManager to send your scanned images to 
another application or not. For details on these selections, see Setting Up 
PageManager for Start Button Scanning.

Because Start button scanning is most useful for scanning text 
documents into an OCR application, these steps use OCR scanning as 
an example. If you’re scanning photographs or other types of documents, 
see Selecting Settings for details on other TWAIN settings you may want 
to select.
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Follow these steps to scan with the Start button:

1 If you’re scanning a single page on the scanner’s document table, 
place the document face down and align its horizontal and vertical 
edges with the scales on the top and right side of the document table.

2 Press the scanner’s Start button.

Dear Friend,

This is a letter that

I am wri ting to you

Start button
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3 In Windows, if you’ve selected more than one application to use with 
the Start button in the Scan Events utility, you see this dialog box:

Click Presto! PageManager for EPSON  and click OK. (If the dialog 
box disappears before you select an application, press the scanner’s 
Start button again.)

4 If PageManager wasn’t running when you pressed the Start button, 
PageManager starts on your system.

If you suppressed the TWAIN interface, the scanner begins scanning 
your document. Go to step 9.

For instructions on 
changing the 
applications available 
for use with the Start 
button, see Enabling 
Scanner Monitoring.

If you suppressed the 
TWAIN interface, you 
must have set the 
correct scan settings 
in the PageManager 
Scan Button Settings 
dialog box to scan 
successfully. See 
Setting Up 
PageManager for 
Start Button 
Scanning for details.
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If you didn’t suppress the TWAIN interface, the EPSON TWAIN 
window opens in PageManager, along with the Scan Buttons bar. Go 
to step 5.

5 To scan a document for an OCR application, select the following 
settings in EPSON TWAIN:

Select the OCR/Line Art  tab.

Threshold :
Select Book or User Defined  (and adjust the slider control until you 
have a clear preview) for the best OCR results.
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Resolution :
Select 300 dpi for the best OCR results.
(If you’re scanning a different type of document, select the settings for 
it as necessary. See Selecting Settings for more information.)

6 Click the Preview  button to prescan the image. 

7 Draw a marquee around the area you want to scan.

8 Click the Scan  button to scan your document. 

EPSON TWAIN scans the document. When scanning is finished, click 
the Close  button to close the EPSON TWAIN window. (If you 
suppressed the TWAIN interface, the EPSON TWAIN window doesn’t 
appear.)

9 If you set up the Start button to load your scanned images into 
PageManager, click the Inbox  icon to view the image in 
PageManager. (See your PageManager documentation for 
instructions on processing images in PageManager.)

If you set up the Start button to load the scanned image into your OCR 
application (or another application), PageManager processes the 
image and opens the application. After a moment, the scanned image 
appears in your selected application window.

10 Now you can follow the instructions in the documentation for your 
application or for PageManager to adjust your image as necessary. 

Make sure you use a 
marquee to select the 
scan area, especially if 
you are scanning at a 
resolution of 300 dpi, or 
higher. See Using 
Marquees for details.
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Using the EPSON TWAIN
Utilities

These sections give instructions for using the utilities installed along with 
EPSON TWAIN to help you scan and calibrate your system:

◗ Using the Scanner Monitoring Utility

◗ Using the EPSON Screen Calibration Utility
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Using the Scanner Monitoring Utility
When you installed EPSON TWAIN on your system, the installer 
automatically installed one of these scanner monitoring utilities:

◗ Scan Events monitor in the Scanners and Cameras utility 
(Windows 98)

◗ EPSON Scanner Monitor (Macintosh)

The scanner monitoring utilities let you use one-touch scanning with the 
scanner’s Start button and the Presto! PageManager software. If you 
installed PageManager when you installed your scanner software, see 
Using the Start Button for instructions on using your scanner monitoring 
utility.
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Using the EPSON Screen Calibration Utility
When you installed EPSON TWAIN on your system, you calibrated your 
screen at the end of the installation sequence. If you change your monitor 
or want to re-calibrate your screen, you can run the EPSON Screen 
Calibration utility again. Calibrating your screen improves the accuracy of 
your preview images in EPSON TWAIN.

Follow the instructions for your operating system in these sections:

◗ Calibrating the Screen with Windows 98

◗ Calibrating the Macintosh Screen

Calibrating the Screen with Windows 98
Follow these steps to calibrate your screen:

1 Click Start, point to Settings, and click the Contro l Panel icon.

2 Double-click the Scanners and Cameras icon. You see this dialog box:

Devices tab

scanner name

Properties button
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3 If necessary, click the Devices  tab. Click your scanner name in the 
box, then click the Properties  button.

4 On the next screen, click the Utility  tab. You see this dialog box:

5 Click the Screen Calibration Utility  icon. You see the following:

Utility tab

Screen Calibration 
Utility icon

View the screen from a 
short distance when 
you calibrate it. The 
gray stripes won’t blend 
perfectly together; 
however, try to make 
them match as closely 
as possible.

before calibration after calibration
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6 Click and drag the slider box or click the left or right slider arrows until 
the shades of the gray stripes match as closely as possible.

7 Click OK . The profile is saved.

8 Click OK  at all the open windows to close them and return to the 
Control Panel.

Calibrating the Macintosh Screen
Follow these steps to calibrate your screen:

1 Open the EPSON Scanner folder and select EPSON Screen 
Calibration . You see the following dialog box:

2 Click and drag the slider box or click the left or right slider arrows until 
the shades of the gray stripes match as closely as possible.

3 Click OK . The profile is saved.

View the screen from a 
short distance when 
you calibrate it. The 
gray stripes won’t blend 
perfectly together; 
however, try to make 
them match as closely 
as possible.

before calibration after calibration
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Troubleshooting

If you encounter any problems using EPSON TWAIN, try the solutions in 
these sections: 

◗ Problems Using EPSON TWAIN

◗ Problems Using the Start Button

◗ Problems with Image Quality

If the information here doesn’t help you solve the problem, check with 
your dealer or contact EPSON. See Where To Get Help for contact 
information.
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Problems Using EPSON TWAIN

The rows in the Screen Calibration dialog box never seem to match closely enough.

When you select a TWAIN source, EPSON TWAIN isn’t listed.

EPSON TWAIN doesn’t start.

Problem Solution

You’re viewing the 
screen too closely.

View the screen from a short distance when you calibrate it. The gray 
stripes won’t blend perfectly together; however, try to make them match 
as closely as possible.

Your monitor 
adjustments may be 
off.

Try adjusting your monitor’s brightness and contrast settings.

Problem Solution

EPSON TWAIN wasn’t 
installed or it wasn’t 
installed correctly. 

Reinstall the software following the instructions in the Scanner Basics 
book.

Problem Solution

The scanner isn’t 
ready.

Make sure the cables are connected properly. Also make sure your 
scanner is plugged in and connected before starting EPSON TWAIN. If 
you started EPSON TWAIN first, exit the program, unplug your scanner, 
then plug it in again, and restart your system.



Troubleshooting Page 48

The scanner does not start scanning.

Your system doesn’t 
meet the minimum 
requirements.

Make sure your computer, scanner, and software are compatible and 
meet the specifications under System Requirements. 

EPSON TWAIN needs 
more memory.

Make sure EPSON TWAIN can access enough system memory. See 
the section on memory allocation in your computer manual.

EPSON TWAIN is not 
selected as your 
TWAIN source.

EPSON TWAIN may not be selected as the TWAIN source in your 
application. See Starting EPSON TWAIN for instructions on selecting it.

A system error has 
occurred.

An error condition may have caused your application or the TWAIN 
source to stop working correctly. Save any documents in process, close 
any open applications, and exit Windows. Restart Windows, then start 
your application and try again.

Sometimes an error condition may cause the computer to display a 
message telling you that your scanner is not recognized. If this happens, 
restart your computer and try again.

Problem Solution

The scanner isn’t 
ready.

Check if the scanner is plugged in. If not, plug in the scanner. Then 
restart your computer and try scanning again.

Problem Solution
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You cannot scan images at all or only a few dots appear in the scanned image.

You’re scanning a large 
image and running out 
of system memory.

If the image you’re scanning is too large or if your system has a 
minimum amount of memory installed, you may run out of memory when 
you scan. You usually get an error message or your system locks up 
when this happens. Reduce the image size or resolution and try 
scanning again. If you still can’t scan the image, add more system 
memory.

If you’ve just scanned a large image in your application and then 
immediately scanned another, the application may not have released 
the memory allocated for the first image. Close your application, restart 
it, and try scanning again. If restarting your application doesn’t solve the 
problem, you may need to reboot your computer.

Problem Solution

You may have selected 
incorrect scan settings.

Select different EPSON TWAIN settings. You may have scanned from 
the wrong tab or selected an incorrect Image Type or Threshold setting. 
See Selecting Settings for details.

Problem Solution
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Problems Using the Start Button

You see the message “No Push button scanner detected.” on your Macintosh.

When you press the Start button, nothing happens.

Problem Solution

Scanner monitoring 
doesn’t detect the 
scanner.

The EPSON Scanner Monitor (Macintosh) periodically checks on the 
status of your scanner to make sure it’s ready. Sometimes the scanner 
check occurs when your system is processing other information and the 
scanner is not detected during that particular check. (You may see this 
message anytime, not just when you press the Start button.)

If you see this message, make sure your scanner cable is securely 
connected. Then open and close the scanner monitoring utility to 
manually check for the scanner. See Enabling Scanner Monitoring for 
instructions. If you still see the message, unplug your scanner, then plug 
it in again and restart your system.

Problem Solution

Scanner monitoring is 
not enabled.

Scanner monitoring must be enabled for the Start button to work. See 
Enabling Scanner Monitoring for instructions.
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When you press the Start button, your system opens programs and scans slowly.

PageManager is not 
installed or the scanner 
monitor isn’t pointing 
to it.

Make sure you installed PageManager correctly as described in the 
Scanner Basics book. Also make sure the scanner monitoring utility still 
points to PageManager as the target application for Start button 
scanning. See Enabling Scanner Monitoring for instructions.

If PageManager starts, but you don’t see the EPSON TWAIN window, 
make sure the destination program or device you assigned to the Start 
button does not suppress the EPSON TWAIN interface. See Assigning a 
Destination to the Start Button for details.

Problem Solution

You assigned another 
destination program to 
the Start button in 
PageManager.

When you set up PageManager to automatically send files scanned with 
the Start button to another application, scanning may take longer. This is 
because your system must use extra resources to open PageManager 
and EPSON TWAIN, and then scan your image, process it, and send it 
to another application. 

Problem Solution
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Problems with Image Quality

The image is distorted or blurred.

Color is patchy or distorted at the edges of the document.

The image is faint or out of focus.

Problem Solution

The document isn’t 
positioned correctly on 
the document table.

Make sure that the document is placed flat against the document table 
and that no part of the original is wrinkled or warped.

You may have moved the document during scanning. Check the position 
of the document.

Make sure the scanner isn’t tilted or placed on an unstable surface.

Problem Solution

The document isn’t 
placed correctly on the 
document table.

If the original is very thick or warped at the edges, the edges of the 
image may be discolored. Cover the edges of the original with opaque 
paper to avoid interference from outside light. 

If part of the original is outside the document table, the edge may be 
discolored. Change the position of the original.

Problem Solution

The document isn’t 
positioned correctly on 
the document table.

Make sure the document is placed flat on the document table.
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The colors on the monitor seem different than the original image or printed image.

Your monitor isn’t 
calibrated or isn’t 
adjusted correctly.

Make sure you have calibrated your monitor to your scanner as 
described in Using the EPSON Screen Calibration Utility. Also check 
your monitor’s brightness and contrast settings. 

Problem Solution

Your monitor may not 
be calibrated correctly.

Depending on your monitor, its resolution/color settings, and your 
EPSON TWAIN settings, the screen colors may be different from the 
original colors. This may be normal, especially if the colors in the printed 
image more closely match the original. Make sure you have correctly 
calibrated the screen as described in Using the EPSON Screen 
Calibration Utility.

Some EPSON TWAIN 
settings may be set 
incorrectly.

Check which image type tab you are scanning from to make sure it is 
correct for the type of image you’re scanning and for the output device 
you’re using. See Selecting Settings for instructions on changing these 
settings.

You may need to use a 
color correction mode.

The colors in the printed image may not match the original image exactly 
because the scanning and printing processes use two different color 
interpreting technologies. Use the Quality  (ICM/sRGB for Windows 98 
or ColorSync for Macintosh) setting in EPSON TWAIN to more closely 
match the colors. See Selecting Settings for instructions. 

You may need to adjust 
your printer driver 
settings.

EPSON TWAIN is optimized to work with EPSON inkjet printers. See 
your printer documentation to change the color matching setting or other 
printer driver settings.

Problem Solution
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The printed image is larger or smaller than the size of the original.

The printer can’t print the image, or the printout is garbled.

Problem Solution

You may have changed 
the image size. 

Check the image size settings in your application. (In HotShots, click 
Get Info  in the Image menu.) Also, some applications display high 
resolution images on lower resolution monitors so they appear larger 
than their original size. 

Problem Solution

Your printer and 
computer may not be 
securely connected.

Check that the printer is properly connected to the computer and is 
correctly set up; see your printer manual.

Your software is not 
installed correctly for 
your printer.

Check that your application software is properly installed and set up for 
your printer; see your application software manual.
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The quality of an enlarged image is worse than when it’s scanned at its original size.

Moiré (crosshatch) patterns appear in the scanned image.

Problem Solution

You didn’t increase 
your Resolution setting 
to compensate for the 
image enlargement.

If you plan to enlarge your image by scaling, be sure to increase the 
Resolution setting by the same proportion to retain your image quality. 
For example, if you select 300 dpi as the resolution setting for an image 
scanned at 100% of its original size and then scale the image 200%, you 
should increase (in this case, double) the resolution to 600 dpi to retain 
the same image quality. See Selecting Settings for instructions on 
changing the Resolution setting.

For additional information on selecting scanning resolution, see your 
Scanner Basics book.

Problem Solution

You have scanned a 
document with halftone 
patterns.

To minimize moiré patterns, try the following:

◗ Place a transparent sheet between the document and the document 
table to slightly unfocus the image.

◗ Move or angle the document slightly.

◗ Make sure De-screening  is selected in the Effect box. See 
Selecting Settings for details.
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Character recognition is inaccurate after OCR scanning.

Problem Solution

You scanned the 
document using 
incorrect source tab.

Scan the document again using the OCR/Line Art tab in EPSON 
TWAIN. This automatically turns on the Text Enhancement Technology 
setting that eliminates background document noise. See Selecting 
Settings for details.
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Where To Get Help
EPSON provides technical assistance through electronic support services 
and automated telephone services 24 hours a day. The following tables 
list the contact information:

Service Access

World Wide Web From the Internet, you can reach EPSON’s Home Page at 
http://www.epson.com .

EPSON Internet FTP Site If you have Internet FTP capability, use your Web browser 
(or other software for FTP downloading) to log onto 
ftp.epson.com  with the user name anonymous  and your 
e-mail address as the password.

EPSON Forum on CompuServe® Members of CompuServe can type GO EPSON at the menu 
prompt to reach the Epson America Forum. For a free 
introductory CompuServe membership, call (800) 848-8199 
and ask for representative #529.
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To speak to a technical support representative, dial (310) 974-1970 (U.S.) 
or (905) 709-3839 (Canada), 6 AM to 6 PM, Pacific Time, Monday through 
Friday. Toll or long distance charges may apply.

Before you call, please have the following information ready:

◗ Product name (EPSON Perfection 610)

◗ Product serial number (located on the back of the scanner)

◗ Computer configuration

◗ Description of the problem

You can purchase manuals and accessories from EPSON Accessories at 
(800) 873-7766 or visit our website at www.epsonsupplies.com (U.S. 
sales only). In Canada, please call (800) 873-7766 for dealer referral. 

Service Access

EPSON SoundAdvice For pre-recorded answers to commonly asked questions 
about EPSON products 24 hours a day, seven days a week, 
call (800) 922-8911.

EPSON FaxAdvice™ Access EPSON’s technical information library by calling 
(800) 922-8911. You must provide a return fax number to 
use this service.

EPSON Referral Service For the location of your nearest Authorized EPSON Reseller 
or Customer Care Center, call (800) 922-8911.

SM

If you need help using 
another manufacturer’s 
software with an EPSON 
product, see the 
documentation for that 
software for technical 
support information.
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Glossary

bit Short for binary digit. The smallest unit of data in computer processing. A 
bit can represent two values, on and off, or 1 and 0.

bit/pixel The unit that indicates the number of bits allocated for a pixel. The larger 
the value, the more detail a pixel can represent.

color correction A method of adjusting the color image data for a particular type of device 
so that the reproduction results come close to the original colors.

default A set of values used when no other selections have been made.

dither A process in which software or an output device simulates continuous 
tones with groups of dots.

dpi Dots per inch. A unit of measurement for resolution. The higher the value, 
the higher the resolution.

Halftone A method of using dot patterns to represent an image.

marquee A sizeable and moveable frame on a preview image that identifies the 
part of it selected for scanning.

monochrome Black and white images, or images represented only by the intensity of 
luminosity.
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pixel Short for picture element. Every image is composed of a number of 
pixels. Pixels are also counted in units of dots.

resolution Indication of how finely an image is resolved into pixels. Measured in dots 
per inch (dpi), pixels per inch (ppi), or samples per inch (spi).

scan An operation performed by the sensor and the carriage of a scanner. The 
sensor “reads” the colors in an image, and sends the color information to 
the computer as digital data.

Threshold An EPSON TWAIN option that sets the point at which gray values in an 
image are represented as either black or white.
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Index

A
Automatic preview, 19

B
Basic scanning, 11

C
Calibration

problems, 47, 53
utility, 43 to 45

Color correction options, 53
Color Management settings, 16
ColorSync, 8, 53

D
De-screening, 16
Destination setting, 17

problems, 49
Destinations for Start button, 27 to 33
Document position problems, 52

E
EPSON

Accessories, 58
help, 57 to 58

H
Help, 57 to 58

I
Image Color Matching (ICM), 53
Image problems, 52 to 54
Image size, adjusting, 54
Image Type setting, 15

M
Manual preview, 19
Manual, how to use, 8 to 9
Marquees, 20 to 21
Memory problems, 48, 49
Moiré patterns, 55
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Monitor
calibrating, 43 to 45, 47, 53
Macintosh, 8
Windows, 7

Monitoring utilities, 6, 23 to 25, 42, 50 to 51

O
One-touch scanning, see Start button
Output device

problems, 49
Output type, 17

P
Placing a document, 37
Presto! PageManager

adding destinations, 29 to 31
assigning destinations, 28
problems using, 51
reassigning destinations, 32 to 33
scan button settings, 33 to 35
Start button scanning, 36 to 40
Start button setup, 27 to 35

Previewing images, 19 to 21

Problems
printing, 54
using Start button, 50 to 51
using TWAIN, 47 to 49

Q
QuickTime, 8

R
Resolution setting, 16, 18

problems, 55

S
Scan button settings, PageManager, 

33 to 35
Scan Events, 6, 23, 24 to 25, 42, 50
Scanner monitoring, 6, 23 to 25, 42, 

50 to 51
Scanning, 10 to 21

basic, 11
with Start button, 36 to 40

Screen calibration
problems, 47, 53
utility, 43 to 45

Service, 57 to 58
Settings, problems with, 49
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Software installation problems, 47, 54
Source settings, 12, 54
sRGB, 53
Start button

enabling scanner monitoring, 23 to 25
preparing to use, 22 to 35
problems, 50 to 51
scanning with, 36 to 40
setting up PageManager, 27 to 35

Support, 57 to 58
System requirements

Macintosh, 8
Windows, 7

T
Threshold setting, 17
Troubleshooting, 46 to 58
TWAIN

previewing, 19 to 21
problems, 47 to 49
settings, 15 to 18
starting, 12 to 14
suppressing interface with Start button, 

29 to 35, 38, 51

U
Unsharp Mask, 16
USB, 7, 8
Utilities, 6, 41 to 45
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